
Support Tipp Pulsonix

Hierarchien helfen bei der Strukturierung von Designs und bei der 
Wiederverwendung oft gebrauchter Schaltungsteile. Hier sollen die 
grundlegenden Verfahren besprochen werden, um erfolgreich hierarchische 
Strukturen zu erstellen.
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Warum Hierarchien 
verwenden?
Es gibt zwei Gründe für die Verwendung einer 
Hierarchie:

• Um einen Schaltplan-Entwurf zu strukturieren, 
sodass er in seine Funktionselemente zerlegt 
werden kann. Dies fördert das Top-Down-Design; 
Zerlegen Sie ein Problem in funktionale Elemente 
und definieren Sie dann die Details jedes 
Elements.

• Um die Wiederverwendung häufig verwendeter 
Schaltungselemente zu erleichtern. Dies fördert 
das Bottom-Up-Design; Verwenden Sie 
vordefinierte Elemente, um eine Lösung zu 
erstellen.

In der Praxis möchten Sie möglicherweise eine 
Kombination aus Top-Down- und Bottom-Up-Design 
verwenden.

Was ist ein Block?
Ein Block sollte ein Funktionselement sein, das einen 
genau definierten Zweck und eine genau definierte 
Schnittstelle hat. Aus gestalterischer Sicht ist ein Block 
ein spezielles Schaltplan-Design, das die 
Implementierung seiner Funktion beschreibt. Außerdem 
ist ihm ein Symbol zugeordnet, das die Schnittstelle 
darstellt.

Ein Block kann in einem Schaltplanentwurf (oder einem 
anderen Schaltplanblockentwurf) instanziiert werden. 
Das Symbol, das den Block darstellt, wird auf ähnliche 
Weise wie eine Komponente in den Schaltkreis eingefügt 
und kann mit ihm verbunden werden. Allerdings wird 
nicht nur das Symbol zum Design hinzugefügt, sondern 
auch alle Seiten des Blockdesigns. Komponenten- und 
Netznamen werden aufgelöst, sodass keine Konflikte 
entstehen. Durch die Verbindung mit den Symbolpins 
werden die Netze mit den in der Blockinstanz definierten 
Netzen verbunden.

In vielerlei Hinsicht unterscheidet sich ein hierarchischer 
Schaltplanentwurf nicht von einem normalen 
mehrseitigen Entwurf. Die Netzlisten wären die gleichen, 
und die Zeichnungen sind weitgehend gleich. Die 
Navigation ist jedoch einfacher, da Sie vom Symbol aus 
in die Seiten hineintauchen können, die die Blockinstanz 
darstellen, und aus der Blockinstanz zum Symbol 
zurückspringen können. Es ist auch möglich, den Inhalt 
einer Blockinstanz ausgehend vom ursprünglichen 
Blockdesign zu aktualisieren.

Hierarchien im Pulsonix Schaltplan
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Top-Down-Design
Um von oben nach unten zu arbeiten, fügen Sie für jeden 
Teil des Entwurfs, der noch nicht definiert ist, eine 
generierte Blockinstanz hinzu. Zu einem späteren 
Zeitpunkt können Sie mit Push die Seiten der 
Blockinstanz einfügen, um diese zu Implementieren. 
Anschließend können Sie über Insert Connection eine 
Verbindung zur Blockinstanz herstellen, indem Sie 
entweder eine Verbindung zu einem vorhandenen Pin 
am Blocksymbol herstellen oder einen neuen 
hinzufügen, indem Sie auf den Symbolumriss klicken.

Bottom-Up-Design
Möglicherweise möchten Sie Bibliotheken häufig 
verwendeter Blöcke erstellen, z. B. Netzteile oder 
Signalwandler. Sie können dies tun, indem Sie einen 
Schaltplan-Hierarchieblock erstellen und ihn in einem der 
angegebenen Schematic-Block-Ordner speichern. Beim 
Erstellen eines schematischen Designs ist es dann 
möglich, eine Instanz eines dieser vorhandenen Blöcke 
in das Design einzufügen.

Navigieren in einem hierarchischen 
Design
Um durch die Hierarchie eines Designs zu navigieren, 
verwenden Sie die Befehle Push und Pop. Um in eine 
Blockinstanz zu tauchen, wählen Sie einen beliebigen 
Teil des Symbols aus und wählen dann im Kontextmenü 
den Befehl Push into block. Um aus einer Blockinstanz 
zum Symbol herauszuspringen, wählen Sie im 
Kontextmenü die Option Pop out of block. Sie müssen 
nichts auswählen, es reicht aus, dass die aktive Seite Teil 
einer Blockinstanz ist.

Durch Hierarchie verbinden
Durch die Instanziierung hierarchischer Blöcke erhalten 
Sie die interne Konnektivität des Blocks, Sie möchten 
diese Netze jedoch über die Hierarchie hinweg 
verbinden. Es gibt zwei Möglichkeiten, dies zu tun.

Wenn das Netz in einem Block als not local (also: 
global) definiert ist, kann es überall im gesamten Design 
verwendet werden. Somit kann innerhalb und außerhalb 
einer Blockinstanz derselbe globale Netzname 
verwendet werden und die angehängten Elemente 
werden miteinander verbunden. Das ist in Ordnung, aber 
Sie sollten die Konnektivität innerhalb einer Blockinstanz 
definieren, mit der keine Verbindung außerhalb der 
Blockinstanz hergestellt werden kann. Dies wird durch 
die Verwendung eines lokalen Namens erreicht. 
Netznamen werden im Technologiedialog definiert. Der 
Umfang eines lokalen Netzes umfasst entweder alle 
Seiten in der aktuellen Blockinstanz oder alle Seiten in 
der obersten Designebene (d. h. alle Seiten, die nicht in 
einer Blockinstanz sind). Lokale Netznamen unterliegen 
einer Reihe von Regeln.

Um ein lokales Netz mit Elementen außerhalb der 
Blockinstanz zu verbinden, müssen Sie einen Blockport 
innerhalb des Blocks verwenden. Dies entspricht einem 
Pin auf dem Blockinstanzsymbol. Die Zuordnung 
zwischen den beiden wird in den Blockeigenschaften 
definiert.

Mehrere Instanzen
Es ist möglich, mehr als eine Instanz desselben 
Blockdesigns in einen Schaltplan einzufügen. Sobald sie 
instanziiert wurden, ist es möglich, sie unabhängig 
voneinander zu bearbeiten, sodass sie von der 
ursprünglichen Definition abweichen. Wahrscheinlicher 
ist, dass Sie die Definitionen gleich halten möchten, 
entweder mit dem ursprünglichen Blockdesign oder 
untereinander. Dies kann erreicht werden, indem Reload
Block vom ursprünglichen Blockdesign aktualisiert wird 
oder indem Änderungen von einer Instanz auf alle 
anderen angewendet werden.

Eine Blockinstanz verfügt außerdem über die Locked
Instance Eigenschaft, die verhindert, dass der Inhalt der 
Instanz bearbeitet oder in irgendeiner Weise geändert 
wird. Dadurch wird sichergestellt, dass es eine Kopie der 
ursprünglichen Definition bleibt. Eine Blockinstanz 
verfügt auch über die Can be Multiply Instanced
Eigenschaft. Wenn Sie dies aktivieren, werden mehrere 
Instanzen des Blocks miteinander verbunden. Nur eine 
dieser Instanzen kann entsperrt und bearbeitet werden. 
Sie können mit Update Multi-Instanced Block wieder in 
Einklang gebracht werden. Wenn Sie eine Instanz eines 
Blocks entsperren und Änderungen daran vornehmen, 
können Sie diese Änderungen verwerfen, um ihn mit den 
anderen gesperrten Blöcken identisch zu machen, indem 
Sie im Kontextmenü die Option Update Multi-Instanced 
Block verwenden.

Beachten Sie, dass Sie zur Verwendung mehrerer 
Instanzen diese in den Design Settings aktivieren 
müssen

Blockinstanzen aktualisieren
Verwenden Sie den Reload Block Befehl aus dem 
Kontextmenü, um die Blockdefinition aus einem 
Blockentwurf neu zu laden. Dadurch werden alle 
Instanzen des Blocks mit denen identisch, die im 
Blockdesign gespeichert sind.

Verwenden Sie den Update Multi-Instanced Block 
Befehl aus dem Kontextmenü, um zu bewirken, dass alle 
mehrfach instanzierten Kopien des Blocks mit der 
entsperrten Instanz identisch werden (es ist nur eine 
entsperrte Instanz zulässig).

Sie können auch das Blockinstanzsymbol aktualisieren. 
Für ein in der Bibliothek gespeichertes Symbol 
verwenden Sie Reload From Library. Für ein 
generiertes Symbol verwenden Sie Regenerate Block 
Symbol.
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Hierarchien erstellen
Top-Down
In diesem Beispiel werden erst die Blöcke angelegt und 
später mit Inhalten befüllt.

Neuen Block erstelllen

1.  Insert > Block Instance oder 

2. Füllen Sie den Dialog aus:

• Generate New Block

• Block Name

• Anzahl Pins

• Beschreibung

• Generated Symbol (Falls es schon ein passendes 
Block Symbol gibt können Sie das mit From 
Library aufrufen).

• Mit Add übernehmen. Sie finden den erzeugten 
Block nun an Ihrem Cursor und können ihn 
platzieren.

• Der Block kann nun über seine Pins mit den Pins 

anderer Blöcke oder Komponenten verbunden 
werden.

Block befüllen

1. Sie können auf mehrere Arten in den Block 
hinabtauchen:

• Selektieren, Rechte Maustaste > Push Into Block

• Selektieren, Bild runter Taste auf der Tastatur 
verwenden

• Ein Doppelklick auf das Blocksymbol

In allen Fällen wir ein Schaltplan geöffnet, der den Inhalt 
des Blocks zeigt. Wenn das das erste Eintauchen in 
einen neu generierten Block ist, dann hat der 
Blockschaltplan noch keine Block Ports, die für die 
Verbindung des Blocksymbols und des Blockschaltplans 
benötigt werden. Dann wird gefragt, ob Sie die Block 
Ports erstellen möchten:



tecnotron elektronik gmbh | Wildberger Halde 13 | D - 88138 Weißensberg
Tel +49 8389 9200-402| Fax +49 8389 9200-96400 | support@tecnotron.de | www.tecnotron-software.de

2. Bestätigen Sie mit Yes, der Insert Block Port Dialog 
erscheint.

3. Wählen Sie ein geeignetes Symbol aus und klicken 
Sie auf Add

4. Sie haben nun das Symbol am Cursor, platzieren 
Sie es im Schaltplan.

5. Platzieren Sie die weiteren Symbole. Falls Sie das 
Symbol ändern wollen (z.B. Input/Output),

6. Wenn alle Pins platziert sind (Anzahl der äußeren 
Block Ports erreicht, erscheint eine weitere Frage:
Falls Sie zu wenig äußere Pins angegeben hatten, 
können Sie OK klicken und weitere Ports 
hinzufügen, ansonsten beenden Sie mit Cancel. 

7. Sie können nun die Innenbeschaltung erstellen, z.B.

8. Mit Rechter Maustaste > Pop out of Block oder der 
Taste Bild rauf kommt man zurück auf den 
darüberliegenden Level. Dort kann man die äußeren 
Blockports anschliessen.

Der Block kann nun auch für die zukünftige 
Wiederverwendung abgespeichert werden. Dafür den 
Block selektieren, Rechte Maustaste > Save To Block 
File. 

Hinweis: Der Speicherort muss unter Setup > Folders 
Schematic Block hinterlegt und aktiv sein, ansonsten 
werden die Blöcke nicht angeboten.

Vorhandenen Block verwenden

1.  Insert > Block Instance oder 

2. Füllen Sie den Dialog aus:

• Use Existing Block

• Look In: Pfad zu Blockdatei auswählen

• Evtl. Block filtern (Name, Anzahl Block Pins)

1. Block Name auswählen

2. Mit Add einfügen. Sie finden den erzeugten Block 
nun an Ihrem Cursor und können ihn platzieren. 
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3. Der Block kann nun über seine Pins mit den Pins 
anderer Blöcke oder Komponenten verbunden 
werden.

Block bearbeiten

1. Sie können auf mehrere Arten in den Block 
hinabtauchen

2. Selektieren, Rechte Maustaste > Push Into Block

3. Selektieren, Bild runter Taste auf der Tastatur 
verwenden

4. Ein Doppelklick auf das Blocksymbol

5. In allen Fällen wir ein Schaltplan geöffnet, der den 
Inhalt des Blocks zeigt, z.B. Hier der Full Adder, der 
selbst zwei Blöcke, die Half Adder, enthält, die 
ebenfalls Blöcke sind in die man hineintauchen 
kann.

Full Adder:

Half Adder:

6. Die Blöcke lassen sich bearbeiten, sofern sie nicht 
gesperrt sind.

Bottom-Up
Die andere Anwendung von Hierarchischen Blöcken ist 
die Wiederverwendung von Teilschaltkreisen. Zum 
Beispiel soll der markierte Schaltungsteil ein 
hierarchischer Block werden, der in zukünftigen Designs 
wieder verwendet werden soll.

 Wählen Sie Edit > Cut To Block.

1. Zeichnen Sie einen Rahmen um den gewünschten 
Bereich (Verwenden Sie ggfs. Polygon Select aus 
dem Kontext Menü (Rechte Maustaste). Der 
Schaltkreis verschwindet, dafür gibt es nun einen 
hierarchischen Block in Form des zuvor 
gezeichneten Rahmens. An den Stellen, an denen 
der Rahmen Connections geschnitten hat, befinden 
sich nun Block Ports, an denen die Connections 
angeschlossen sind.
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2. Selektieren Sie das Block Symbol und öffnen Sie 
seine Properties (Über das Kontext Menü oder mit 
dem Hotkey I).

Hier können Sie dem Block einen 
Referenzbeweichner geben , oder eine 
Beschreibung, diese können Sie mit den 
Checkboxen im Design sichtbar machen, oder 
Eigenschaften setzen (Can be Multiply Instanced, 
Create PCB Group oder Locked Instance)

3. Schließen Sie den Dialog mit OK.

4. Tauchen Sie mit Doppelklick, oder der Taste Seite 
runter oder Push aus dem Kontext Menü in den 
Block ein.  

Dort finden Sie die ausgeschnittene Teilschaltung, 
die Sie jederzeit ändern können, sofern sie nicht 
gesperrt ist.

5. Steigen Sie mit der Taste Bild hoch wieder in den 
Top Level.

6. Sie können die Darstellung des Block Symbols 
ändern (s. nächstes Kapitel), indem Sie im 
Kontextmenü die Befehle Edit Symbol oder Edit 
Symbol in Place verwenden (s. nächstes Kapitel).

7. Sie können das Block Symbol (inkl. seiner Inhalte) 
speichern indem Sie es selektieren und sein Kontext 
Menü den Befehl Save To Block File aufrufen. 

(Denken Sie daran, dass der Speicherort unter 
Setup > Folders > Schematic Blocks im Suchpfad 
steht und aktiv ist).

8. Sie können diesen Block nun im gleichen Design 
oder in einem anderen öffnen, indem Sie den schon 
bekannten Insert Block Instance Befehl 
verwenden.

Block Symbole bearbeiten, speichern, 
reloaden
Es gibt mehrere Möglichkeiten ein Blocksymbol zu 
editieren, im Design oder im Blockeditor.

• Im Design sieht man den umgebenden Schaltplan 
im Hintergrund, dadurch kann man besser seine 
Größe abschätzen und die beste Position für die 
Block-Ports finden. 

• Im Editor bearbeitet man den Block im Block-
Editor, das Design ist dann nicht zu sehen. Der 
Block-Editor kann sowohl Blocksymbole im Design 
oder direkt aus dem Dateiordner für Blöcke öffnen 
und Bearbeiten.

Im Design bearbeiten

1. Block im Design selektieren

2. Kontext Menü > Edit Symbol in Place

3. Sie können das Symbol in Form und Größe 
anpassen.

4. Sie können Block-Ports hinzufügen, löschen oder 
verschieben.

5. Sie können den Block mit Texten oder Grafiken 
versehen.

6. Sobald Sie mit der Bearbeitung fertig sind, 
verwenden Sie das Kontext Menü > Exit Edit 
Symbol In Place.

7. Sie können den Block nun auch speichern (s.unten)

Im Editor bearbeiten

1. Block im Design selektieren, dann Kontext Menü > 
Edit Symbol oder Kontext Menü > Components/
Symbols > Edit Symbol

2. Oder den Block über File > Open in seinem 
Speicherort öffnen.

3. Sie können das Symbol in Form und Größe 
anpassen.

4. Sie können Block-Ports hinzufügen, löschen oder 
verschieben.

5. Sie können den Block mit Texten oder Grafiken 
versehen.

Speichern 

Sie können einen Block speichern, indem Sie den schon 
bekannten Insert Block Instance Befehl verwenden.

1. Hierarchischen Block selektieren

2. Kontext Menü öffnen (Rechte Maustaste)

3. Den Befehl Save To Block File aufrufen 
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(Denken Sie daran, dass der Speicherort unter Setup > 
Folders > Schematic Blocks im Suchpfad steht und 
aktiv ist).

Reloaden

Es kommt vor, dass ein platzierter hierarchischer Block in 
der Bibliothek geändert wurde (Genauer: In seinem 
Dateiordner) und nun in einem Design upgedated 
werden muss. Das geschieht über den Reload Befehl.

1. Selektieren Sie den Block im Design

2. Öffnen Sie sein Kontext Menü (rechte Maustaste)

3. Wählen Sie Reload Block.

Schalten Sie ggfs. die Einstellungen um.

4. Bestätigen Sie mit OK, der Block im Schaltplan 
wird, mit dem aus dem Dateiordner, überschrieben.

5. Sie erhalten ggfs. einen Dialog, in dem Sie 
festlegen können, welche Netznamen beibehalten 
und welche neu vergeben werden. 
Checkbox:  
Ein - Behalten 
Aus - neuer Name 

Multiple Blocks
Wenn Sie einen Block mehrfach brauchen, können Sie 
ihn einfach kopieren oder nochmals aus dem Insert > 
Block Instance Menü platzieren. Manchmal sollen die 
gleichen Instanzen eines Blocks aber nicht nur mehrfach 
vorkommen, sondern miteinander verknüpft sein, d.h. 
wenn man einen dieser verknüpften Blöcke ändert, 
sollen sich alle verknüpften Blöcke synchronisieren und 
damit wieder identisch sein.

Für diese Multiple Instanced Blocks gibt es einige 
wichtige Dinge zu beachten:

1. Die Verwendung von Multiple Instanced Blocks 
muss erlaubt sein – Das geschieht unter Design 
Settings > General > Allow Multiply Instanced.

2. Den ersten Block als Multiple Instanced markieren. 
Dafür den Block selektieren, dann Kontext Menü > 
Properties oder Hotkey I. Register Block Instance

3.  Can be Multiply Instanced aktivieren und mit OK
übernehmen.

4. Den Block selektieren und kopieren. Alle Kopien 
sind nun mit dem ‚Master‘ und den anderen Kopien 
verknüpft.

Sie können die Blöcke nun platzieren und anschließen. 
Falls Sie jedoch versuchen in einem dieser Blöcke etwas 
zu verändern, wird das nicht gehen, da alle Blöcke 
gesperrt sind. Wie kann man nun Änderungen 
vornehmen?

1. Selektieren Sie einen beliebigen dieser Blöcke 
(Hinweis: Es gibt keinen Master Block, durch die 
nächsten beiden Schritte machen Sie den 
selektierten Block zum Master).

2. Öffnen Sie seine Properties (Hotkey I oder Kontext 
Menü > Properties. Register Block).

3. Schalten Sie Locked Instance ab.

4. Tauchen Sie in den entsperrten Block ein. Sie 
können hier nun arbeiten, also hinzufügen, löschen, 
ändern.

5. Wenn Sie mit den Änderungen fertig sind, tauchen 
Sie aus dem Block auf. 

6. Tauchen Sie testweise in eine der Kopien ein, Sie 
werden dort noch den vorherigen Zustand finden. In 
der Kopie können Sie nichts ändern. Tauchen Sie 
wieder auf.

7. Synchronisieren der Blöcke: Selektieren Sie einen 
der Blöcke und öffnen Sie das Kontextmenü. Dort 
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klicken Sie auf Update Multi-Instanced Block. 
Pulsonix übernimmt die Änderungen in alle 
verknüpften Blöcke. Alle Blöcke sind nun wieder 
gesperrt. 

8. Wenn Sie die Änderungen nicht speichern wollen, 
und stattdessen seine Inhalte wieder mit denen der 
anderen anpassen (zurücksetzen) wollen, dann 
verwenden Sie das Kontext Menü > Revert Multi-
Instanced Block.

Sonstiges
Den Block als Gruppe für die Platzierung im PCB 
verwenden

Da Bauteile, die im Schaltplan nebeneinander liegen, 
meist auch im Layout beieinander liegen, kann man sie 
im Schaltplan gruppieren, damit man sie im Layout über 
die Gruppe aufrufen kann. Da der hierarchische Block 
die Komponenten sowieso schon zusammengefasst hat, 
ist es sinnvoll den Block zu verwenden, anstatt zusätzlich 
eine Gruppe zu definieren. Schalten Sie in den Block 
Properties einfach den Schalter Create PCB Group ein, 
dann sind die darin befindlichen Komponenten in einer 
Gruppe mit dem Blocknamen zusammengefasst. 

[SU]

Technischer Support: 
Weitere hilfreiche Dokumente bekommen Sie auf www.
tecnotron-software.de/de/service/faqs/

Falls Sie Fragen zur Installation, Anwendung oder 
Vorgehensweisen haben stehen wir Ihnen gerne zur 
Verfügung über unsere Supporthotline: 

Tel.: +49 8389 9200-402 

E-Mail: support@tecnotron.de 

Wir bieten regelmäßige Pulsonix Schulungen an. 
Informationen finden sie unter www.tecnotron-software.
de/de/service/seminare/


